
FY 2016 Page 1 
 

 

 
 

 
 

Ohio ABLE 
Level Two Technology 

Manual 
 

 
 
 
 
 
 
 
 
 
 
 
 



FY 2016 Page 2 
 

The Ohio ABLE Technology Standards for Staff are designed to introduce ABLE practitioners to the basic 
concepts of technology. The Areas of Competency include:  
 
1. Basic Concepts of Information Technology (IT)  
2. Productivity Software  
3. Information and Communication  
4. Technology Enhanced Programs and Classrooms  
5. Professional Development  
 
These handouts and resources are designed to support the Indicators and Benchmarks for each Area of 
Competency.  
 
The information is designed to be used with:  
 
PC-based computers/laptops  

Internet Explorer/Chrome/Firefox  

Microsoft Office 2007 or later  

Windows 7 or later  
 

The Level 1 Technology Standards were developed by the Ohio ABLE Technology Task Force during 
FY08. They were initially distributed to ABLE Directors in Fall 2008. Updates were made in FY12 and 
released to the field in FY13. The Level 2 Technology Standards were developed in the Fall of FY15 and 
distributed to ABLE Directors Spring of FY15. 
 
This manual was compiled by Matthew Gambrill, Ohio Literacy Resource Center, Kent, Ohio. 
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Standard 1: Basic Concepts of Information Technology (IT) 

Indicators Benchmarks 

2.1.1 ABLE staff is knowledgeable of 
computer components and 
their functions. 

2.1.1.1 Can assist students and peers with basic computer 
operations on various types of desktop PC’s. 

2.1.1.2 Can utilize available input/output devices as needed (e.g., 
input: scanner, microphone, webcam / output: printer, 
projector, speakers). 

2.1.1.3 Can identify file size and file types using icons and 
extension (e.g., file size: KB, MB, GB / file type: .pdf, .mov, 
.doc, .mp3). 

2.1.2 ABLE staff can perform 
intermediate computer 
operations. 

2.1.2.1 Can access networked/remote storage locations. 

2.1.2.2 Can back up important files. 

2.1.2.3 Can install/uninstall programs as needed. 

2.1.3 ABLE staff can troubleshoot 
common problems. 

2.1.3.1 Can communicate effectively using basic computer 
terminology to seek help. 

 

The goal of this Standard is to be knowledgeable of computer components, terminology and functions.   
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2.1.1 Basic Knowledge of Computer Components and Their Functions 

2.1.1.1 Can assist students and peers with basic computer operations on various types of desktop 

PC’s. 

Apply your knowledge of the Level 1 Technology standards to provide guidance to students and peers for a 

variety of computing scenarios. 

2.1.1.2 Utilize Available Input/Output Devices 

Component  Important Information Tips 

Microphone 
 

   
 

 For recording sound and 
participating in web 
meetings  
 

 If you sound like you are 
under water or have echoes 
or excessive background 
noise, try switching to a 
different microphone or 
USB headset 

Webcam 
 

  

 For recording video and 
participating in web 
meetings 
 

 If your video looks blurred, 
try cleaning the lens with a 
cloth.  A fingerprint smudge 
can be enough to blur the 
lens  

 Video uses a lot of 
bandwidth to transmit, so 
your video quality will vary 
depending on the 
connection   

Scanner  
 

 

 Captures a digital image of 
a physical copy 
 

 Can be used to convert 
paper based worksheets, 
forms, photographs to a 
digital format   

 Use Optical Character 
Recognition (OCR) to make 
text searchable 

Printer 

 

 Laserjet printers cost more 
up front, but print more 
pages per dollar  

 Inkjet printers can be 
cheap, but replacement 
cartridges will add up  

 Print in black and white and 
lower the print quality to 
save money and print more 
pages.  A lower quality print 
will still be readable. 

Projector 

 
 

 Used to display a computer 
and other video sources in 
a classroom.   

 If you can’t connect your 
computer or device to a 
projector, you may need an 
adapter.  

Speakers 

      

 Used to make audio 
accessible to the whole 
classroom 

 Look for a mix of portability 
and sound quality when 
selecting speakers 
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2.1.1.3 File Size and File Types 

File Size  

You have a fixed amount of space on your storage device and managing that requires just a little bit of 

conceptual knowledge.  In computing, storage space is measured in bytes and metric prefixes are used to 

denote powers of 10.  A simple way to think about this is to approximate the prefixes as a thousand, a million, 

a billion, and a trillion bytes.   

Name Size in Bytes So what does that store? 

Kilobyte (KB)  1,024  Word Document 

Megabyte (MB) 1,048,576  Mp3 audio file 

Gigabyte (GB) 1,073,741,824  DVD quality video 

Terabyte (TB) 1,099,511,627,776 Capacity of modern hard drives  

 

 

Common scenario:  You are trying to copy pictures to a flash drive and you get a message saying that the 

drive is full.  You want to keep all your pictures on one flash drive, so how big of a drive will you need to copy 

all your pictures?   
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File Types 

There are far too many file types to list, but generally you only need to be concerned with the ones that relate 

to your computing needs.  Your main concern with file types is compatibility, because programs can only work 

with certain types of files.  Listed below are some of the most common file types you are likely to encounter. 

Audio Files 
.mp3 MP3 Audio File 
.wav WAVE Audio File 
.wma Windows Media Audio File 
 
Video Files 
.mp4 MPEG-4 Video File 
.mpg MPEG Video File 
.wmv Windows Media Video File 
 
Image Files 
.png Portable Network Graphics 
.jpg Joint Photographic Experts Group 
.bmp Windows Bitmap 
.gif Graphics Interchange Format 
 
 
 

Compressed Files 
.7z 7-Zip Compressed File 
.zip Zipped File 
 
Document Files 
.doc Microsoft Word Document 
.docx Microsoft Word Open XML Document 
.pdf Portable Document Format 
 
Data Files/Spreadsheets 
.csv  Comma Separated Values  
.xls Excel Spreadsheet 
.xlsx Excel Open XML Spreadsheet 
 
Presentations 
.ppt PowerPoint Presentation 
.pptx PowerPoint Open XML Presentation 
 

 

 

Files on the computer have a graphical icon that will help you identify the file type.  If you don’t recognize the 

icon, right click on the file and select Properties from the menu to find out the file type. 

Common Scenario: You create a presentation using Apple’s Keynote on a Mac computer and you want a 

colleague to review it, but they use a Windows computer with Microsoft PowerPoint.  What can you do? 
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2.1.2 Intermediate Computer Operations 

2.1.2.1 Networked and Cloud-based Storage 

Networked storage means you access files stored on another computer linked through a local network to your 

computer or device.  Network storage can be used to access a bank of lesson plans, forms and templates, 

instructional resources, and other files that are commonly accessed by a group.  To access a networked 

storage location, go to the Start menu and click on Computer.  Listed under Network Locations will be a list 

of networked storage drives.  If your networked storage drives requires authentication, you will need to log in 

with a username and password. 

 

Cloud-based storage is similar to networked storage.  Your files are stored on a computer accessed by your 

computer or device over the Internet.  This provides extra flexibility by letting you to access your files at any 

location with an Internet connection just by signing into the service.  In recent years, free and low-cost cloud-

based storage options have become increasingly common.  Below are a few popular free services that offer 

cloud-based storage options. 

Box – http://box.com  

Dropbox - http://dropbox.com  

Google Drive – http://drive.google.com 

Microsoft OneDrive – https://onedrive.live.com  

http://box.com/
http://dropbox.com/
http://drive.google.com/
https://onedrive.live.com/


FY 2016 Page 10 
 

2.1.2.2 Backup Important Files 

It is important to understand that technology fails and you may lose all your files if you do not back them up. 

The easiest way to back up important files is to copy them to a USB flash drive.  Just plug it into your computer 

and copy your important files to it.  Stick a mailing label or a piece of masking tape on it, mark it as “Backup”, 

and keep it in a safe place.  Make sure to update your back up files as needed.   Backup needs will vary, so 

figure out a schedule that fits with your routine and computer usage. Advanced backup software are available 

for both Windows and Mac that will automate the process, but will require some additional configuration. 

 

2.1.2.3 Install/Uninstall Programs 

Installing 

Most software for Windows based systems use a program that will automate the installation process.   When 

installing software, be careful to read through all the steps.  Some software comes bundled with other 

programs that will be installed by default.  Usually there will be a box that you need check or uncheck 

depending on the wording.   

Uninstalling 

Some programs include an Uninstall option.  To access it, click the Start button, 

go to All Programs and look for the Uninstall menu option. 

DANGER ZONE!  You can really screw your day up messing around here.  

Seek help if you aren’t sure what to do! 

In Windows, click the Start button, then click on the Control Panel > Programs 

> Uninstall a Program.  This will bring up a list of all the programs installed on 

your computer.   Select a program from the list and click Uninstall.  Some 

programs will not have an uninstall command and you will see an option for 

Change/Repair.  Click on Change/Repair to bring up the option to uninstall. 
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2.1.3 Troubleshooting Common Problems 

2.1.3.1 Can communicate effectively using basic computer terminology to seek help. 

Computers are complicated.  There  are lots of things can go wrong with hardware and software and trying to 

figure a problem can be a frustrating experience.  There are two simple tips for dealing with common problems:  

 Make sure all your cables are connected properly.   

 Reboot your computer or turn the device off and back on. 

If you are still having problems, make sure to write down everything you are doing, making special note of any 

error messages you receive.  The more details you document about a problem, the easier it will be to convey 

that information to someone who can help.   

For more information, see the Basic Troubleshooting Techniques tutorial found at 

http://www.gcflearnfree.org/computerbasics/15. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://www.gcflearnfree.org/computerbasics/15
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Standard 2: Productivity Software 

Indicators Benchmarks 

2.2.1 ABLE staff can use the 
functions of a word processing 
program to create a variety of 
documents. 

2.2.1.1 Demonstrates fluency of basic word processing features (i.e. 
cut, copy, paste, highlight, headers, footers). 

2.2.1.2 Can learn and use new features of a word processing 
program (i.e. subscript and superscript, bullets). 

2.2.1.3 Can use functions of a word processing program to create 
and format tables  
 

2.2.1.4 Can insert graphics into documents, move, and resize.  

2.2.2  ABLE staff has basic 
knowledge of spreadsheets 

2.2.2.1 Knows commonly used formulas. 

2.2.2.2 Can filter and sort data. 

2.2.3 ABLE staff has basic 
knowledge of presentation 
software 

2.2.3.1 Can create simple presentations and modify prepared 
templates 

 

The goal of this Standard is to be able to use common productivity software for word processing, 

presentations, and spreadsheets.  There are a few major productivity software suites that offer similar 

functionality.  The most commonly used are Microsoft Office/Office Online, Google Docs, and OpenOffice.  For 

the purposes of this guide, the examples provided are using Microsoft Office 2010.  Most of the functionality 

covered in the following pages is also found in Office Online, Google Docs, and OpenOffice. 

Google Docs - https://www.google.com/docs/about/  

Microsoft Office Online - https://office.live.com/start/default.aspx 

Apache OpenOffice - https://www.openoffice.org/  

 

 

 

 

 

 

 

 

 

 

 

 

https://www.google.com/docs/about/
https://office.live.com/start/default.aspx
https://www.openoffice.org/
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2.2.1 Use the Functions of a Word Processing Program to Create a Variety of 

Documents 

2.2.1.1 Demonstrates fluency of basic word processing features 

 

Microsoft Office 2007 and on use a tab based menu.  Most of your formatting functions can be found under the 

Home tab. Under the Home tab you will find the Cut/Copy/Paste functions and commonly used formatting 

features like bold, italicize, font, font size, left/right/center justification, and so on. 

Highlight 

To highlight, move your cursor to the beginning of the text or graphics you want to select.  Once you are in 

position, left click with your mouse and hold the button down then drag your mouse across the text or 

graphics.   

 

Cut/Copy/Paste 

Cut will remove the selected text/graphics from its current position.  Copy will duplicate the selected 

text/graphics and leave the original in its current position. Paste will insert the selected text/graphics to a new 

position.  

To Cut/Copy/Paste, highlight a selection of text/graphics and do one of 

following:  

Right click to bring up the context menu options   - OR - 

Left click on the menu options in the top left corner of the window  
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Keystroke shortcuts are also a good way to speed up the Cut/Copy/Paste 

process.  Once you highlight your selection, press the following keys in 

combination: 

Press and hold [Ctrl] then [X] to Cut 

Press and hold [Ctrl] then [C] to Copy 

Press and hold [Ctrl] then [V] to Paste 

 

 

Header and Footer 

Headers and Footers are found at the top and bottom of each page in a document.  Double click at the top or 

bottom of a document to bring up the Header and Footer options.  Use them to insert titles, dates, names, and 

page numbers on each page of the document.  For a title page without the Header and Footer, check the box 

for “Different First Page” in the Options under the Design tab. 

 

 

2.2.1.2 Can learn and use new features of a word processing program  

 

There are a lot of advanced features built in to word processing software.  These options allow you to change 

the document line spacing, modify text or graphics, and create bulleted or numbered lists to help organize 

information.  It is safe to experiment with these features because anything you do can be rolled back by 

clicking the Undo  button found at the top left of the window. 
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2.2.1.3 Can use functions of a word processing program to create and format tables 

To insert a table into a document, click the Insert tab and use the Table drop down menu to select the number 

of Rows and Columns.   

 

 

2.2.1.4 Can insert graphics into documents, move, and resize 

To insert a graphic into a document, click the Insert tab and select one of the Illustration menu options.  Use 

the Picture option to browse your files and insert a graphic (e.g. logo, pictures from a field trip, or infographic) . 

 

Once you have inserted a graphic, you can resize and move it around the document.  To resize, right click 

and hold on a dot, then drag your mouse to resize.   

 

 

Tip: Use the corner dots to resize the height and width 

at the same time. 
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2.2.2  Basic Knowledge of Spreadsheets 

 

2.2.2.1 Knows commonly used formulas 

Basic Formulas 

Spreadsheets can be used to automate calculations for a variety of purposes. Once your data is entered into 

the cells, formulas can be set up to perform routine calculations like sales tax, sum totals, averages, and 

more.  Cell addresses (e.g. A1, A2, B3, C25) are used like variables and you need to apply the rules for order 

of operations for calculations to work correctly.  All formulas start with an equals sign (=) and basic operations 

require the following symbols (+  -  *  /  ^). 

Apply 

Click on a cell, type an equals sign (=) and enter a simple formula. 

In the examples below, cells A3 contains the formulas =A1+A2 and =A1*A2 

                                                                                               

Complex Formulas 

To calculate things like sales tax or percentages, you will need to apply the order of operations to your 

formulas.  In Excel, formulas are calculated in the following order: 

1. Parentheses 

2. Exponents 

3. Multiplication and division 

4. Addition and subtraction 

Tip:  Remember the mnemonic PEDMAS (Please Excuse My Dear Aunt Sally) to remember your order of 

operations. 
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Apply 

Click on a cell, type an equals sign (=) and enter a complex formula using parentheses to set up your order of 

operations.  In the example below, Column A uses the formula (A1+B2)/A2 and Column B uses =A1+B2/A2 

                                               

For more information, see the Complex Formulas tutorial at http://www.gcflearnfree.org/excel2013/14  

 

2.2.2.2 Sort and Filter Data 

Sort Data 

The Sort function is a quick way to organize data alphabetically or numerically.  To Sort data, you need to 

highlight a range of cells, then right click and select from the Sort menu option.   

              

 

http://www.gcflearnfree.org/excel2013/14
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Filter Data 

The Filter function is used to sort data by specific criteria.  In the example below, we will set up a filter to sort 

out only the names that begin with the letter J.  

To start, click on the column where you want to apply the filter and select Filter from the Sort & Filter 

dropdown menu near the top right. 

 

A dropdown menu will now be available in the first row of your column.  Click on the dropdown menu to display 

your Text Filter options.  Click on the Begins With option, type your filter criteria and click OK. 

 

Once you apply your filter, your spreadsheet will only show the values that match your criteria. 
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2.2.3 Basic Knowledge of Presentation Software 

Presentation software is the standard tool for organizing and presenting content.  While you may traditionally 

think of text on slides, presentation software can also be used to sequence images, tell stories, play games, or 

to create flashcards.  When working with presentation software, you can apply your knowledge of basic 

formatting operations like font size, alignments, and bullet points.   

The screenshot below is of Microsoft PowerPoint 2010, but there are many options available for creating 

presentations today including Prezi, Keynote, and Google Slides to name a few.  

 

 

2.2.2.1 Using a Presentation Template 

Creating a presentation from scratch can be time consuming.  To save time, it is a good idea to use a 

template.  Templates will give you a consistent design theme applied across all of your slides.   The basic 

concept behind a template is that all slides are copied from a Master slide.  The Master slide has a 

background image and custom font styles that will provide consistency to your presentation.  A template file 

may be provided by your program or you can download one from the many free sources available.   

http://www.presentationmagazine.com/free_powerpoint_template.htm 

Tip:  Keep a few things in mind when designing a presentation.  Try to reduce slide clutter, utilize high contrast 

colors for text and backgrounds, and avoid unnecessary animations. 

 

 

 

 

http://www.presentationmagazine.com/free_powerpoint_template.htm
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Standard 3: Information and Communication 

Indicators Benchmarks 

2.3.1 ABLE staff can connect to the 
Internet.  
 

2.3.1.1 Can recognize and connect to appropriate networks when 
available  
 

2.3.2 ABLE staff can use a Web 
browser application and 
search engine tools to access 
information.  
 

2.3.2.1 Can incorporate instructional resources from the Internet 
into lesson plans, classroom activities and student research 
projects.  
 
 

 

2.3.2.2 Can evaluate accuracy and authority to determine the 
credibility of digital information (e.g., who is the author, what 
are the author’s qualifications, what is the purpose and 
content). 

2.3.2.3 Can demonstrate the use of search engines such as 
Google, Bing, etc. using targeted searches and key words. 

2.3.3 ABLE staff can use email 
software to send, receive, and 
organize messages.  

2.3.3.1 Understands basic netiquette when using communication 
tools  
 

2.3.3.2 Understands the appropriate use of zip files, email lists, 
Reply All, CC, and BCC. 

2.3.4 ABLE staff understands basic 
legal issues and appropriate 
use of the Internet and Digital 
Communication. 

2.3.4.1 Can define and model appropriate use of the Internet.  
 

2.3.4.2 Understands the issue of “CyberBullying” and can effectively 
monitor same in the classroom. 

2.3.4.3 Understands the PII (Personally Identifiable Issues) as 
related to Cloud Storage  
 

2.3.4.4 Can demonstrate basic knowledge of intellectual property 
and explain appropriate use of electronic media (e.g., 
copyright, fair use, public domain, Creative Commons 
licensing).  

 

The goal of this Standard is to be proficient in connecting to the Internet, accessing websites and utilizing 

email. 
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2.3.1 Connecting to the Internet 

2.3.1.1 Secure vs Public Wireless Connections 

You will encounter two main types of wireless connections, secure and public wifi.  Secure connections require 

a password to connect and are safe for checking emails, paying bills, banking, and other sensitive Internet 

activities.  Public wifi connections are not encrypted and should only be used for basic Internet browsing (e.g. 

looking at web pages).   

 

2.3.2 Using a Web Browser and Search Engine 

2.3.2.1 Incorporate Instructional Resources in to Lesson Plans 

In recent years, the availability of instructional resources has increased dramatically and you can now access 

tens of thousands of resources with just a few clicks. Use your web browsers bookmarking function to save the 

sites you would like to visit regularly to find instructional resources.  

Online Teacher Resource Center - http://trc.ohioable.org/  

PBS Learning Media – www.pbslearningmedia.org   

Open Educational Resources - www.oercommons.org  

PhET Interactive Simulations – www.phet.colorado.edu 

Keep one rule in mind when selecting multimedia to incorporate into your lesson:does the technology enable 

you to do something with the content that you couldn’t do otherwise?  Think about conducting science 

experiment that will demonstrate the concept of phase changes.  Will a hands-on experiment be too time 

consuming or messy to demonstrate in class?  Would a simulation be a suitable substitute for a hands-on lab?   

 

2.3.2.2 Evaluating Web Pages for Accuracy and Credibility 

Evaluating a page for accuracy and authority requires asking a few simple questions to determine whether or 

not the information you are reading can be considered credible.     

Accuracy: Who wrote it? What are their qualifications? What is the purpose of the document? 

Authority: Who published the document? Are the authors’ credentials or affiliations listed?  Is there a 

bibliography or reference list for citations? 

Tip: Many web pages have biographical information about the author(s) and staff.  Look for a link that says 

“About Me” or “About Us”. 

 

For more information, see the Cornell University Library Evaluating Web Pages LibGuide found at 

http://guides.library.cornell.edu/c.php?g=32334&p=203767   

 

http://trc.ohioable.org/
http://www.pbslearningmedia.org/
http://www.oercommons.org/
http://www.phet.colorado.edu/
http://guides.library.cornell.edu/c.php?g=32334&p=203767
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2.3.2.3 Using Search Engines 

Targeted Searching 

If at first you don’t succeed, try a different combination of keywords and look at the results.  As you search, 

refine your queries based on keywords that generate the best results.  

Operators 

Place a minus sign (-) in front of a word to remove results containing that term (e.g. search for information on 

panthers, exclude results for pages about the NFL and NHL sports teams [panthers –NHL –NFL]). 

Place quotes around words to search for a phrase exactly as it appears (e.g. search for Contextualized Lesson 

Plans with and without quotes [“contextualized lesson plans” vs contextualized lesson plans]) 

Place an asterisk to search for unknown or wildcard terms (e.g. a search for [work*] would return results for 

work, workforce, and workplace) 

Popular search engines include Google, Bing, and DuckDuckGo. 

 

2.3.3 Sending, Receiving, and Organizing Emails 

2.3.3.1 Understands basic netiquette when using communication tools 

Online communication can lead people to say and do things they would never do in public.  When using ICT 

tools, keep things civil and apply the Golden Rule of treat others as one would like others to treat oneself. 

 

2.3.3.2 Understands the appropriate use of zip files, email lists, Reply All, CC, and BCC. 

An email list is a subscription based email service primarily used to distribute messages.  It is also used to 

facilitate discussions between subscribers.  When you want to discuss something with an individual and not the 

whole group on an email list, it is good etiquette to send a message to the email list saying you will contact 

the person “off the list”.   

CC stands for Carbon Copy.  Use to send a copy of an email message to a group. 

BCC stands for Blind Carbon Copy. Use to send a copy of an email to a group and hide the recipient 

addresses. 

Reply All will send to an email to all recipients of an email. Use to reply to the whole group. 

Zipped files compress and package a file or files into a single folder.  Use to bundle multiple attachments into 

a single file. 
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2.3.4 Basic Legal Issues and Appropriate Use of Digital Communication 

2.3.4.1 Model Appropriate Use 

When working with others to teach them the rules of the road on the Internet, it is important to address some 

basic concerns.  This includes creating secure passwords, safe surfing, logging off services when using public 

computers, prohibiting access to explicit content, sharing personal information, and downloading or sharing 

files for non-academic purposes.  A good way to do this is to create set of guidelines that is clearly posted and 

everyone has to agree to before using a computer to access the Internet.  Make sure to check with your 

organization first to see if there is an Acceptable Use Policy in place and to ensure consistency with existing 

guidelines. 

 

2.3.4.2 Personally Identifiable Information (PII) 
 
“Any information about an individual maintained by an agency, including (1) any information that 
can be used to distinguish or trace an individual‘s identity, such as name, social security number, date and 
place of birth, mother‘s maiden name, or biometric records; and (2) any other information that is linked or 
linkable to an individual, such as medical, educational, financial, and employment information.” 
http://www.gao.gov/new.items/d08536.pdf  

The idea behind PII is that large amounts of personal information are gathered by computer systems ranging 

from medical records to frequent shopper cards.  This information has become a valuable commodity and is 

highly sought after by legal and illegal enterprises.  The main goal is to limit the exposure of sensitive 

information.  Don’t email social security numbers or store student data in a cloud-based service.  

http://www.privatewifi.com/pii-chart-educates-against-identity-theft-fraud-scams/  

 

2.3.4.3 Cyber-bullying 

The perception of anonymity on the web has led to bizarre and disturbing incidents of online harassment.   

There are three terms used to describe online harassment.  The first is cyberbullying, which is when only 

minors are involved.  If an adult becomes involved, the appropriate terminology is cyberharassment or 

cyberstalking.  Cyberharassment refers to adults using technology to harass, annoy, or deride another 

individual.  Cyberstalking refers to adults using technology to spy and track another person’s online activity.   

The most important thing to remember when dealing with any type of online harassment is to avoid escalating 

the situation.  Tell the individual to stop all contact and keep a record of any messages received.  If the 

harassment continues or a violent threat is made, you need to seek help through the appropriate channels. 

For more information and resources on how to deal with online harassment, go to 

https://www.wiredsafety.org/subjects/cyberbullying.php  

 

 

 

http://www.gao.gov/new.items/d08536.pdf
http://www.privatewifi.com/pii-chart-educates-against-identity-theft-fraud-scams/
https://www.wiredsafety.org/subjects/cyberbullying.php
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2.3.4.4 Intellectual Property 

Instantly accessible information and media online does not mean that you have free reign to appropriate 

copyright protected materials. 

Copyright/Public Domain/Creative Commons 

When dealing with media online, you’re going to encounter materials governed by copyright laws.  Copyright 

laws protect intellectual property and it is necessary to seek permission from the rights holder to make use of 

materials.  Some materials can also be found in the public domain.  This class of materials has fallen out of 

copyright protection and can be used freely.  There is also a newer class of intellectual property licensing 

known as Creative Commons that permits reuse of materials under variety of terms. See 

https://creativecommons.org/licenses/ for specific license terms.  

The Open Educational Resource (OER) below is licensed for reuse under Creative Commons Attribution-

Noncommercial-Share Alike 3.0. 

 

https://www.oercommons.org/courses/density-differences 

 

 

 

 

 

 

 

 

 

https://creativecommons.org/licenses/
https://www.oercommons.org/courses/density-differences
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Standard 4: Technology-Enhanced Programs and Classrooms 

Indicators Benchmarks 

2.4.1 ABLE staff can select, 

incorporate and evaluate the 

use of technology in the 

program and classroom. 

2.4.1.1 Can select and manage learning activities incorporating 

technology and digital media. 

2.4.1.2 Can assist students to set up distance learning options. 

2.4.2 ABLE staff can use computer-

based assessments and 

software, where applicable. 

2.4.2.1 Can utilize programs to create quizzes and customized 

authentic assessments. 

2.4.3 ABLE staff is knowledgeable 

of means to make technology 

accessible for adults with 

special needs. 

2.4.3.1 Is familiar with available assistive technology for special 

needs (e.g., text to speech, large print keyboard, screen 

magnification, speech recognition). 

 

The goal of this Standard is to be knowledgeable about selecting and using technology for instruction, program 

operations and student learning. Additionally, staff is to be competent in adjusting technologies to meet the 

needs of students with special needs. 

2.4.1 Select and manage learning activities incorporating technology and digital 

media 

2.4.1.1 Can select and manage learning activities incorporating technology and digital media.  

When determining which technology you should incorporate into your learning activities, there are a few 

resources that can help you identify what outcomes you should be looking to meet.  These resources include 

the 2012 PIACC, the College and Career Readiness Standards, and the TESOL Technology Standards 

Framework. 

The recent PIAAC survey highlights an important area of concern for adult educators trying to prepare their 

students to navigate in the 21st century (http://nces.ed.gov/surveys/piaac/sample_pstre.asp).  

Problem-solving in technology rich environments 

Example:  Your daughter is sick with the flu and you get the missed days assignments from the teacher so she 

doesn’t fall behind.  The assignments are sent as attachments and the teacher tells you to email back the 

completed assignment.   

http://nces.ed.gov/surveys/piaac/sample_pstre.asp
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Example:  You are starting a job search online.  Search for and identify the sites that are free, then bookmark 

and register an account. 

College and Career Readiness 

There is a significant emphasis in two of the anchor standards on technology and multimedia.  One 

emphasizes the receptive skills of evaluating diverse electronic media formats and the other deals with the 

productive skills of using technology to write and communicate with others. 

CCR Anchor 7 - Reading 

 

CCR Anchor 6 - Writing 

 

http://lincs.ed.gov/publications/pdf/CCRStandardsAdultEd.pdf  

 

TESOL Technology Standards Framework 

The TESOL Technology Standards Framework sets goals for both students and teachers.  See the full guide 

for implementation tips for low tech, some tech, and high tech classrooms. 

http://www.tesol.org/docs/books/bk_technologystandards_framework_721.pdf?sfvrsn=2  

http://lincs.ed.gov/publications/pdf/CCRStandardsAdultEd.pdf
http://www.tesol.org/docs/books/bk_technologystandards_framework_721.pdf?sfvrsn=2
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Technology Standards for Language Learners 

Goal 1: Language learners demonstrate foundational knowledge and skills in technology for a multilingual 

world. 

Goal 2: Language learners use technology in socially and culturally appropriate, legal, and ethical ways. 

Goal 3. Language learners effectively use and critically evaluate technology based tools as aids in the 

development of their language learning competence as part of formal instruction and for further learning. 

Technology Standards for Language Teachers 

Goal 1. Language teachers acquire and maintain foundational knowledge and skills in technology for 

professional purposes. 

Goal 2. Language teachers integrate pedagogical knowledge and skills with technology to enhance language 

teaching and learning. 

Goal 3. Language teachers apply technology in record-keeping, feedback, and assessment. 

Goal 4. Language teachers use technology to improve communication, collaboration, and efficiency. 

 

2.4.1.2 Assist students to set up distance learning options 

ABLE programs have access to a wide range of distance education curricula approved by the state.  These 

curricula can enable self-directed students with computer and Internet access to continue their learning outside 

of the classroom.  When appropriate refer a student to your program’s distance education options. 
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2.4.2 ABLE staff can use computer-based assessments and software, where 

applicable 

2.4.2.1 Utilize programs to create quizzes and customized authentic assessments 

There are a wide variety of programs and services that allow you to create custom assessments.  There are 

programs and services that enable you to generate and assign assessments to students from a bank of 

content like That Quiz.  There are programs and services that allow you to create the whole thing from scratch 

like Google Forms.  There are programs and services that allow you to do on the fly polling to check for 

student understanding like Poll Everywhere.  Some programs offer a mix of services like quiz generators, 

quick polling, and creating custom assessment like Edmodo and Socrative.  Check out the links below to get 

a feel for how the different services operate. 

That Quiz - http://www.thatquiz.org 

Google Forms - http://www.google.com/forms/about/  

Poll Everywhere – http://www.polleverywhere.com  

Edmodo – http://www.edmodo.com  

Socrative - http://www.socrative.com/  

 

2.4.3 ABLE staff is knowledgeable of means to make technology accessible for 

adults with special needs 

2.4.3.1 Is familiar with available assistive technology for special needs 

Text to Speech 

Text to speech programs will read the text from a document.  The document can be a web page, an email, a 

Word document, a PDF, or other files that contain text.  Some programs include an option to slow down or 

speed up the rate at which the text is read and can be adjusted to accommodate a student’s preferred pace. 

Natural Reader is a free text to speech program.  The basics are free, but you can buy extra features including 

more natural sounding voices.    

http://www.naturalreaders.com/  

Free Text to Speech is another option.  This program allows you to export the converted text as an audio file.   

http://www.mediafreeware.com/free-text-to-speech.html  

Speech Recognition 

Speech recognition software is highly useful for students that have difficulty spelling or typing.  One of the most 

popular commercial software options is Dragon Naturally Speaking.  If you want to try the technology for free, 

Windows features a built-in speech recognition programs in its ease of access tool suite. To access go to your 

Start menu, click on All Programs > Accessories > Ease of Access > Windows Speech Recognition.  

 

http://www.thatquiz.org/
http://www.google.com/forms/about/
http://www.polleverywhere.com/
http://www.edmodo.com/
http://www.socrative.com/
http://www.naturalreaders.com/
http://www.mediafreeware.com/free-text-to-speech.html
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Large Print Keyboard 

Large print and high visibility keyboards can be purchased from many vendors.  Large print keyboard stickers 

are also available that can be used to modify an existing keyboard.   

Screen Magnification 

If enlarging the text on screen or switching to a high contrast theme does not help students with visual 

impairments, screen magnification may be able to help accommodate student usage.  Windows features a 

built-in magnifier in its ease of access tool suite.  To access go to your Start menu, click on All Programs > 

Accessories > Ease of Access > Magnifier. 
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Standard 5: Professional Development 

Indicators Benchmarks 

2.5.1 ABLE staff can model lifelong 

learning in technology. 

2.5.1.1 Actively promotes new technology and best practices to 

peers. 

2.5.1.2 Demonstrates understanding of importance of technology to 

careers, lifelong learning, and daily life (e.g., productivity 

software, OhioMeansJobs, LinkedIn and other social 

media).  

2.5.2 ABLE staff will participate in 

professional development 

related to technology.  

 

2.5.2.1 Stays current with evolving PD opportunities and formats.  

 

2.5.2.2 Can access all ABLE-related websites, Moodle and other 

links to PD opportunities.  

2.5.2.3 Understands how to participate in various digital/virtual 

activities (e.g., CoPs, Webinars, listservs, alternative PD 

Offerings).  

 

The goal of this Standard is to be knowledgeable and users of technology for professional development. 

 

2.5.1 ABLE staff can model lifelong learning in technology 

2.5.1.1 Actively promotes new technology and best practices to peers 

One of the big advantages of ICT is the ability to share your knowledge and experience with your peers.  If you 

find a technology or approach that has merit, it is important to share it with others.  

 

2.5.1.2 Demonstrates understanding of importance of technology to careers, lifelong learning, and 

daily life  

It is important to recognize the impact of technology on society.  For students today, many pathways to 

opportunity will require the use of technology.  In order for students to succeed, you need to be knowledgeable 

enough to help guide students through the technology necessary to pursue their individual objectives. 
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2.5.2 ABLE staff will participate in professional development related to 

technology.  

2.5.2.1 Stays current with evolving PD opportunities and formats.  

Online PD opportunities are available through a wide variety of sources.  Online courses, study groups, and 

webinars are all viable alternatives to face to face training.  Subscribe to OhioLit to stay connected and receive 

important emails about professional development opportunities. 

http://literacy.kent.edu/Oasis/mailinglists.html   

 

2.5.2.2 Can access all ABLE-related websites, Moodle and other links to PD opportunities.  

There are a few sites you need to know to access important information and professional development 

opportunites: 

www.ohioable.org – For general information related to the Ohio ABLE system 

www.ohioable.org/online – Online learning management system for professional development 

www.ohioablelibrary.org – Online public access catalog for reserving library materials 

www.ohiohighered.org/able/reference – Ohio Department of Higher Education page for important forms and 

policies 

www.lincs.ed.gov – Literacy Information and Communication System 

 

2.5.2.3 Understands how to participate in various digital/virtual activities 

Online professional development opportunities require a little bit of preparation prior to participating.  Make 

sure you review the instructions provided for participating in a PD opportunity thoroughly.   The basic minimum 

requirements are usually just a decent computer and an Internet connection.  Listed below are primary 

technologies used to facilitate PDN sponsored professional development. 

Moodle – Learning management system (See Appendix A) 

Webex – Web meeting system  

Adobe Connect – Web meeting system 

 

 

 

 

 

http://literacy.kent.edu/Oasis/mailinglists.html
http://www.ohioable.org/
http://www.ohioable.org/online
http://www.ohioablelibrary.org/
http://www.ohiohighered.org/able/reference
http://www.lincs.ed.gov/


FY 2016 Page 32 
 

 

 

 

 

 

Appendix A 



 
 

PDN – September 2013  Page 1 of 2 

Accessing a Moodle Course 
 

The Ohio ABLE Professional Development Network (PDN) houses most of its online courses on a site called 
Moodle. Accessing these courses is a simple process and just takes a few minutes to set up. The Moodle site 
can be accessed at ohioable.org/online. However, before you can complete a course in Moodle, you must 
register for the course through the Ohio ABLE PD System.   

 
 
Step 1: Register for the course in the Ohio ABLE PD System. (If you have already registered 

for the course, please skip to step 2.) 
A. Log in to the Ohio ABLE PD System using your name and ABLE System ID. 
B. Click on the link at the top of the page that says “Register.” 
C. Click on the link at the top of the page that says “self-directed options.”   
D. Choose the training you would like to register for, and click on the link. 
E. At the top right of the screen, click on the link that says “Register here!”  
F. On the page that comes up, click on the gray button that says Register for your training. Please make 

sure you don’t skip this step as your registration will not go through until you click that button.   
G. All the information you need for accessing the course will be found on the registration confirmation 

page. Print this page and save it. You are now ready to move to the Moodle.  
  
 

Step 2:  Create a Moodle account (if you have not already done so). 
A. Click on “Login” at 

the top right corner. 
B. Select the “Create 

new account” button 
on the bottom right 
side. 

C. Fill out the form and 
make note of your 
selected username 
and password.  

D. An email will be 
immediately sent from “Tim Ponder” to your email address. (If you have not received an email from Tim, 
check your “junk” or “spam” folder. Sometimes Tim’s emails get filtered there.) 

E. Read the email, and click on the web link it contains to confirm your account.  
F. From now on you will only need to enter your personal username and password to log in for access to 

any course in which you enroll.  
 

Step 3: If you are not familiar with Moodle, watch the “Moodle Orientation” video. It is 

about five minutes long and guides you through navigating the site. 
A. Log in to Moodle. 
B. Select “Moodle Orientation” from the course listing. Click on “Enroll me.” 
C. You will now be logged into the “Moodle Orientation” and have access to the video.  

 
 

Fast Fact 
Enrollment keys are required to access most content on 
the Moodle. If you didn’t write down your enrollment key 
after registering, log in to the Ohio ABLE PD System, click 
on the link titled “PD History,” and then click on the name 
of the course.   

http://www.ohioable.org/online
http://mercury.educ.kent.edu/database/rcn/registrations/login.cfm
http://mercury.educ.kent.edu/database/rcn/registrations/login.cfm
http://www.ohioable.org/online/
http://mercury.educ.kent.edu/database/rcn/registrations/login.cfm
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Step 4:  Enroll in the course you have selected.   

A. Log in to Moodle. 
B. Select the course you wish to complete from the listing of courses on the left side of the screen.   
C. When you are prompted for an “enrollment key,” please enter the enrollment key for the course. This 

key was listed on the registration confirmation page when you registered for the course. To revisit the 
page to obtain the key, log in to the Ohio ABLE PD System, click on the link titled “PD History,” and 
click on the name of the course. Please note that enrollment keys are case sensitive. 

D. Once the enrollment key is entered, you will have full access to the course.   
 
 

Step 5: Complete all parts of the course. 

A. Complete all parts of the course. You will not be able to access the evaluation and certificate until you 
have completed all parts of the course.   

B. Fill out the evaluation. You must fill out the evaluation to get a certificate.   
 

 

Step 6: Save and send your certificate to be marked as complete.  

A. Once you have completed your evaluation, click on the gray button that says “Get Your Certificate” at 
the top of the page.  

B. When the pop-up window opens, save a copy.   
C. Depending on the versions of the programs installed on your computer, you will need to click on the File 

menu option for “Save As” or the icon for “Save a Copy” or “Download.”    
D. Before you save it, type in a name for the file and choose a location to which to save it. The desktop is 

usually an easy place to find it. You may even want to create a folder on your desktop to store all your 
PD certificates.   

E. Go into your email. Create an email message to ablecert@osu.edu. Attach a copy of the certificate to 
the email. Once this email has been received, PDN staff will mark your PD History as complete.   

 
 
If you need additional assistance with this process, please contact:  
    

Ohio ABLE Professional Development Network  
ohiopdn@literacy.kent.edu 
(800) 765-2897, option 2 

AIM: ohiopdn 
ohioable.org 

 
 

 
 

 

Fast Fact 
Certificates need to be saved to your computer and sent 
as attachments to ablecert@osu.edu for your PD History 
to be marked as complete.     

http://mercury.educ.kent.edu/database/rcn/registrations/login.cfm
mailto:ablecert@osu.edu
mailto:ohiopdn@literacy.kent.edu
http://www.ohioable.org/
mailto:ablecert@osu.edu

